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 Important Information

Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
FieldPoint™, Lookout™, National Instruments™, NI™, ni.com™, and NI-FBUS™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

FCC/Canada Radio Frequency Interference Compliance

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products.

Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the 
Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital 
electronics emit weak signals during normal operation that can affect radio, television, or other wireless products.

All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated.

Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 

Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the 
FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference 
at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance to EU Directives
Users in the European Union (EU) should refer to the Declaration of Conformity (DoC) for information* pertaining to the 
CE marking. Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance 
information. To obtain the DoC for this product, visit ni.com/hardref.nsf, search by model number or product line, 
and click the appropriate link in the Certification column.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.



Conventions

The following conventions are used in this manual: 

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names.

Fieldbus The generic term Fieldbus refers to any bus that connects to field devices. 

This includes Foundation Fieldbus, CAN, DNET, and Profibus. In this 

manual, the term Fieldbus refers specifically to the Foundation Fieldbus.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. This font also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames and extensions, and code excerpts.



© National Instruments Corporation vii NI-FBUS Offline Configurator User Manual

Contents

Chapter 1
NI-FBUS Offline Configurator Overview

Introduction to the NI-FBUS Offline Configurator .......................................................1-1

NI-FBUS Offline Configurator Windows .....................................................................1-1

Device Type Tree ............................................................................................1-3

Configuration Tree .........................................................................................1-3

Run Mode of Current Project ..........................................................................1-4

Chapter 2
Device Descriptions

Importing Device Descriptions ......................................................................................2-1

Chapter 3
Using the NI-FBUS Offline Configurator

Start the NI-FBUS Offline Configurator and NIFB Process .........................................3-1

Create a New Project .....................................................................................................3-3

Add Virtual Devices ......................................................................................................3-4

Configure Function Block Application..........................................................................3-7

Mapping and Downloading ...........................................................................................3-8

Appendix A
Error Messages and Warnings

Appendix B
Technical Support and Professional Services

Glossary

Index



© National Instruments Corporation 1-1 NI-FBUS Offline Configurator User Manual

1
NI-FBUS Offline Configurator 
Overview

This chapter introduces the NI-FBUS Offline Configurator, lists 

some of its main features, and describes the main windows of the 

application. This manual is written for persons already familiar with 

Windows 2000/NT/XP and the Foundation Fieldbus Overview document, 

and who are otherwise familiar with using Foundation Fieldbus.

Introduction to the NI-FBUS Offline Configurator

You can use the NI-FBUS Offline Configurator to configure a Foundation 

Fieldbus network and keep track of your configuration changes. The 

NI-FBUS Offline Configurator is a graphical environment for creating 

linkages, loops, and a schedule based on the concepts described in the 

Foundation Fieldbus Overview document.

NI-FBUS Offline Configurator Windows

The NI-FBUS Offline Configurator has three resizable windows within the 

main window: the configuration tree, help window, and status window. 

You can open additional specialty windows in the middle frame to 

configure your function block applications, change parameters, and update 

the schedule. You also can open separate windows for block parameter 

adjustment on top of the main window. Figure 1-1 shows elements of the 

NI-FBUS Offline Configurator main window.
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Figure 1-1.  Elements of the NI-FBUS Offline Configurator Main Window

At the upper-right corner of the screen are two sets of resize buttons. 

The outer set of buttons controls the NI-FBUS Configurator, and the inner 

set controls the currently active window in the middle frame. If you cannot 

see other windows in the middle frame, minimize the active window.

Refer to the NI-FBUS Configurator User Manual for more information.
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Device Type Tree
The device tree window, which appears to the left of the configuration tree, 

shows the existing virtual device types already imported into NI-FBUS as 

shown in Figure 1-2.

 

Figure 1-2.  Existing Virtual Device Types in the Device Tree Window

The device types are grouped by vendor name. Click the + symbol to view 

the device types belonging to each manufacturer.

Configuration Tree 
Unlike in the online version of NI-FBUS, the configuration tree does not 

appear on the upper left of the NI-FBUS configurator window. It appears 

between the device type tree and middle frame.
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Run Mode of Current Project
The run mode indicates the run mode of the current active project. Offline 

means the current project is running in offline mode, while Online means 

it is running in online mode.

Note You can dock the configuration tree on the left side of the main window. To do 

so, select View»Preferences, select the General page, and check the Dock Device 

Type Window in the Right Side box to keep the device type window on the right side. 

In addition, when NI-FBUS Configurator quits, the latest information in the status 

window, download window, and mapping window are automatically recorded in the 

statuslog.txt, downloadlog.txt, and maplog.txt files, respectively. However, 

all previous information is overwritten.

Refer to the NI-FBUS Configurator User Manual for more information.
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2
Device Descriptions

The device description files contain information about the types of blocks 

and parameters your Fieldbus device supports, along with online help 

describing the uses of given parameters.

Importing Device Descriptions

If your Fieldbus device uses manufacturer-specific device description files 

that shipped with the device or are available from the device manufacturer, 

you must import them. To do so, complete the following steps:

1. Insert the device description disk or CD (if supplied by your Fieldbus 

device manufacturer) into the disk drive of the host computer.

2. Select Start»Programs»National Instruments»NI-FBUS» 

Interface Configuration Utility to run the Interface Configuration 

utility. The utility appears in Figure 2-1.

Figure 2-1.  NI-FBUS Interface Configuration Utility



Chapter 2 Device Descriptions

NI-FBUS Offline Configurator User Manual 2-2 ni.com

3. Click the Import DD/CFF button. The Import DD/CFF dialog box 

appears as shown in Figure 2-2.

Figure 2-2.  Import DD/CFF Dialog Box

4. Click the DD Info button. The DD Info dialog box appears as shown 

in Figure 2-3.

Figure 2-3.  DD Info Dialog Box

5. If the base directory field is blank, enter a base directory. The base 

directory you enter here is where NI-FBUS looks for all device 

descriptions. Do not change the base directory after you have started 

importing device descriptions; otherwise, NI-FBUS cannot find the 

device descriptions you previously imported. Your device description 

files are automatically placed in the appropriate manufacturer ID 

subdirectory under this base directory. Your base directory includes 

one folder for each manufacturer for which you have imported a device 

description. For example, if you import the device description for the 

National Instruments FP-3000 device, you will find a folder called 

4e4943. This is the National Instruments Foundation Fieldbus device 

manufacturer ID number. The next layer of folders is the device type. 

For example, the FP-3000 has a device type ID number of 4005. 

Underneath this layer of directories, you will find the individual device 

description files and capability file (.ffo, .sym, and .cff).
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6. If necessary, click the Browse button to select the standard text 

dictionary provided with NI-FBUS. The text dictionary has a .dct 

extension.

7. Click the Browse button in the Import DD/CFF dialog box and select 

All Files (*.*) in the Files of type pull-down menu. Browse to the 

.cff capability file as shown in Figure 2-4 and click Open. 

Figure 2-4.  Selecting the Capability File

Typically, the device description files and capability file for your 

Fieldbus device are supplied on a disk from the manufacturer. For each 

device, there is one capability file (.cff) and two device description 

files, one ending in .ffo and one in .sym. Select the .cff file. The 

corresponding .ffo and .sym files are imported automatically. The 

filename has six digits and a .cff extension (for example, 

030101.cff). 

Note If you are importing device descriptions and capability files for multiple devices, 

you might see that they can have the same filenames. Each file contains information about 

the device and its manufacturer, and is placed appropriately in the hierarchy under the base 

directory. 

8. Click OK. A window appears, giving the full path to which the .cff, 

.ffo, and .sym files were copied.

9. Click OK again.

For more information about device descriptions, refer to the Device 

Descriptions section of the Foundation Fieldbus Overview and Foundation 

Specification Common File Format (FF-103) documents.
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3
Using the NI-FBUS Offline 
Configurator

The tutorials in this chapter give you first-hand experience with the 

NI-FBUS Offline Configurator.

Before you begin these exercises, make sure you have successfully installed 

all Fieldbus hardware and software and have properly imported the device 

descriptions for the devices you want to use.

Start the NI-FBUS Offline Configurator and NIFB Process

1. Install the NI-FBUS Offline Configurator software in your machine.

2. Import the device descriptions and capability files.

3. Select Start»Programs»National Instruments»NI-FBUS» 

NI-FBUS Interface Configuration Utility to start the NI-FBUS 

Interface Configuration Utility. Click Add Interface. The dialog box 

in Figure 3-1 appears.

Figure 3-1.  Choosing an Interface Type
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4. Select Offline and click Continue to add an offline virtual interface. 

You can point out or click OK to use the node address given in the 

dialog box. The offline configurator installer already may have 

installed an offline virtual interface. In this situation you do need to add 

an extra interface.

Note NI-FBUS cannot work with any physical interface in the offline state. Remember to 

delete any existing physical interfaces before you add an offline interface. Only one offline 

interface is supported in the current version.

5. To start the NI-FBUS Offline Configurator, select Start»Programs» 

National Instruments»NI-FBUS»NI-FBUS Configurator. When a 

dialog box appears, click Off-line Mode to start NIFB.EXE with the 

offline mode as shown in Figure 3-2.

Figure 3-2.  Starting the NI-FBUS Offline Communications Manager
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Create a New Project

1. When you start the NI-FBUS Configurator, the Add Links dialog box 

appears automatically. To create a new project at any other time, select 

File»New.

Figure 3-3.  Create a New Project

You should close any open projects before opening or creating another 

project. The multiple window structure of the NI-FBUS Configurator 

quickly becomes confusing with multiple open projects.

2. In the Add Links dialog box, each configured interface appears. Select 

the link or links (ports on your Foundation Fieldbus interface) you 

want to include in your project in the Added link(s) checklist.
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3. Select the type of project to create as shown in Figure 3-4. Usually, this 

type is offline.

Figure 3-4.  Project Type Selection

4. Click OK.

Add Virtual Devices

1. Drag the device you want to add into the current project from the left 

window (device type tree) and drop it into the middle window (project 

window). The device list windows show the devices in hierarchy and 

group the devices from the same vendor under a folder. You can 

right-click the device types and select Property to view detailed 

information as shown in Figure 3-5.
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Figure 3-5.  Adding Virtual Devices
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2. When a virtual device is dropped into the project window, the 

following window prompts the user to set the FF network address and 

tag of the virtual device. The NI-FBUS Offline Configurator sets the 

default values. You can simply use the default address and tag, for they 

have been checked to ensure no repetition with other offline devices. 

You also can fill in the desired address and device tag, then click OK 

to add this virtual device as shown in Figure 3-6.

Figure 3-6.  New Address and New Tag

3. The NI-FBUS Offline Configurator creates a virtual interface and 

multiple virtual devices added by the user. The virtual devices are 

created from DD and CFF files. If you provide incorrect DD or CFF 

files, the corresponding virtual device may not work properly, as 

shown in Figure 3-7.
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Figure 3-7.  Virtual Devices Added Into Fieldbus

Configure Function Block Application

After the desired virtual devices have been created by the NI-FBUS Offline 

Configurator, you can configure your function block application.

1. Select Function Block Application in the project window containing 

the configuration tree.

2. Select Start»Programs»National Instruments»NI-FBUS»Manuals 

to view the NI-FBUS Communications Manager User Manual for 

detailed configuration information.

3. After you make the configuration, you can save the project into a 

*.fcp file. This file can be transported to other machines for mapping 

and downloading.
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Mapping and Downloading

As used here, mapping means mapping the virtual devices into physical 

devices. You must do the mapping in the online state, meaning you must 

have a physical interface and devices. Complete the following steps to map 

and download:

1. Select Start»Programs»National Instruments»NI-FBUS» 

NI-FBUS Interface Configuration Utility to start the NI-FBUS 

Interface Configuration Utility. Add your physical interfaces (either 

AT, PCMCIA, or PCI interfaces).

2. Select Start»Programs»National Instruments»NI-FBUS» 

NI-FBUS Configurator to start the NI-FBUS Configurator. The 

configurator will ask you select the run mode. Click Online Mode 

to start it.

3. As the Configurator launches, check the Open option in the 

startup dialog box and open the .fcp file you saved in the Offline 

Configurator. A window prompts you to initialize the link, as shown 

in Figure 3-8.

Figure 3-8.  Initializing the Link
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4. After the link initializes, a list shows the virtual (offline) devices versus 

physical (online) devices. You can select the strategy to decide which 

device’s address to use as the target, as shown in Figure 3-9.

Figure 3-9.  Select Target Tags and Addresses

5. After you set target addresses, click Map to begin the mapping. With 

Concurrent Mapping checked, all selected devices are mapped in 

parallel to speed up the mapping process. You can uncheck this box to 

map the devices one by one. (The default mode is concurrent.) With 

Map Network Parameters checked, the network parameters in the 

selected link are mapped. However, only the network communication 

parameters are mapped. The error values set up in the virtual link to be 

mapped to the physical link can make the communication unstable. 

Therefore, uncheck this box if you are not sure the network parameters 

are correct. (The default state is unchecked.)

In addition, before the mapping, the program automatically backs 

up the offline project to another file with _off added to the name. 

(For example, if the original file is C:\org.fcp, the backup file is 

C:\org_off.fcp). The NI-FBUS configurator erases the devices 

with conflicting tags or addresses, then maps the virtual offline devices 

to physical online devices, as shown in Figure 3-10.
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Figure 3-10.  Erase Conflicts and Perform Mapping

6. After all the virtual devices you selected are mapped (you can have 

more or fewer physical devices than virtual devices), the mapping 

ends, as shown in Figure 3-11.
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Figure 3-11.  Partially Mapped Link

The grayed item with a red M at the beginning of the row indicates that 

the device has been mapped. Select Yes to download the configuration 

immediately, or No to end the mapping. To download the configuration 

later, select Download All from the menu.

Tip To log the information created while mapping and downloading, select View» 

Preferences. On the Log Settings page, input the log filenames, click the Start Log 

button, and click OK.

Note In the process of mapping, some parameter value errors may occur. Generally, 

you can ignore them and continue or try to do mapping again. In addition, both mapping 

warnings and errors are recorded in the mapping status window, which is helpful in 

verifying the mapping.
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A
Error Messages and Warnings

This appendix lists error messages and warnings you might receive while 

using the NI-FBUS Configurator and describes the error messages and 

warnings.

Error Messages

If you receive an error message while using the NI-FBUS Configurator, 

refer to this section for a description of the error and possible solutions.

NIF_ERR_ALARM_ACKNOWLEDGED

The alarm has already been acknowledged.

NIF_ERR_BAD_ARGUMENT

The value you gave is not of the correct data type.

NIF_ERR_BAD_DEVICE_DATA

The device returned inconsistent information.

NIF_ERR_BUF_TOO_SMALL

The buffer does not contain enough entries to hold all the information for 

the blocks. If you receive this error, buffer entries that you allocated did not 

contain valid block information when the call returned.

NIF_ERR_COMM_ERROR

An error occurred when NI-FBUS tried to communicate with the device.

NIF_ERR_CONFIG_ERROR

Some configuration information, such as Windows registry information or 

network configuration information, is incorrect.

NIF_ERR_DATA_NEVER_WRITABLE

The specified object is read-only.
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NIF_ERR_DEVICE_NOT_PRESENT

The requested device is not operational.

NIF_ERR_EXCEED_LIMIT

The device reported that the value exceeds the allowable limit during a 

write operation.

NIF_ERR_INVALID_DESCRIPTOR

The descriptor you gave is invalid.

NIF_ERR_MULTIPLE

There are duplicate block tags.

NIF_ERR_NOT_FOUND

NI-FBUS could not find the specified object.

NIF_ERR_OBJECT_ACCESS_DENIED

The Fieldbus interface does not have the required privileges. The access 

group you belong to is not allowed to acknowledge the event, or the 

password you entered is incorrect.

NIF_ERR_OBJECT_ACCESS_UNSUPPORTED

The device does not support write access to this object.

NIF_ERR_OBSOLETE_DESC

The input descriptor is no longer valid. It was closed before a function 

completed.

NIF_ERR_ORDINAL_NUM_OUT_OF_RANGE

The ordinal number is out of the device’s range.

NIF_ERR_PARAMETER_CHECK

The device reported a violation of parameter-specific checks.

NIF_ERR_RESOURCES

NI-FBUS is unable to allocate some system resource; this is usually a 

memory problem.
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NIF_ERR_SERVER_CONNECTION_LOST

The session established with NI-FBUS for this descriptor has been closed 

or lost.

NIF_ERR_SERVER_NOT_RESPONDING

Either the NI-FBUS server has not been started, or the server, in its current 

state, cannot respond to the request.

NIF_ERR_SM_NOT_OPERATIONAL

The device is present, but cannot respond because it is at a default address.

NIF_ERR_SYMBOL_FILE_NOT_FOUND

NI-FBUS could not find the symbol file.

NIF_ERR_TIMEOUT

The device containing the object is present but did not respond within the 

timeout period.

NIF_ERR_WRITE_IS_PROHIBITED

The device reported that the WRITE_LOCK parameter value is set. 

The WRITE_LOCK parameter prohibits writing to the name parameter.

NIF_ERR_WRONG_MODE_FOR_REQUEST

The device reported that the current function block mode does not allow 

you to write to the parameter.

NIFCONF_ERR_ADDRESS_OUT_OF_RANGE

This address does not fit in the allowable range of addresses.

NIFCONF_ERR_ADDRESS_USED

This address is already taken.

NIFCONF_ERR_BAD_WIRE

This wire is not completely attached to an output and input(s).

NIFCONF_ERR_BLOCK_SCHEDULE_CONFLICT

A block in this device is already scheduled for this time. Do not schedule 

more than one block in the device at the same time.
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NIFCONF_ERR_BUF_TOO_SMALL

The buffer is too small.

NIFCONF_ERR_CONFIGURING

You are configuring this project. If you get this error, stop configuring the 

project to continue.

NIFCONF_ERR_CONFUSED_WIRE

This wire is not working. The NI-FBUS Configurator has removed it.

NIFCONF_ERR_CORRUPT_FILE

The NI-FBUS Configurator found a corrupt file object.

NIFCONF_ERR_COULD_NOT_DETERMINE_SCHEDULE

The NI-FBUS Configurator cannot fit the schedule of the loop into the 

current schedule. Usually, insufficient time or poor choice of loop times 

cause this error. Use integer multiples such as 1, 2, 4, and so on, instead of 

multiples like 5, 7, 13, and so on, to solve this problem.

NIFCONF_ERR_COULD_NOT_START_THREAD

The NI-FBUS Configurator is unable to start a new thread.

NIFCONF_ERR_DD_SIZE_MISMATCH

The actual data size does not match the device description data size.

NIFCONF_ERR_DEVICE_NOT_ALIVE

The device is not responding.

NIFCONF_ERR_DOWNLOAD_INCOMPLETE

The link is only partially configured.

NIFCONF_ERR_DUPLICATE_ADDRESS

The address for this device was found elsewhere in the configuration file. 

Duplicate addresses are not allowed on a Fieldbus link.

NIFCONF_ERR_DUPLICATE_TAG

The tag for this object was found elsewhere in the configuration file. 

Duplicate tags are not allowed on a Fieldbus link.
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NIFCONF_ERR_INCOMPATIBLE_VERSION

This file was made with a newer version of the NI-FBUS Configurator. 

There might be unpredictable problems with the project.

NIFCONF_ERR_INVALID_MACROCYCLE

This macrocycle conflicts with a previously defined macrocycle.

NIFCONF_ERR_INVALID_NUMBER

This is an invalid number. A number can use the digits 0–9 and the letters 

A–F. Hexadecimal numbers can be preceded with 0x.

NIFCONF_ERR_INVALID_TAG

This tag is not valid.

NIFCONF_ERR_INVALID_VALUE

You have entered an incorrect value. Please check the value(s) and the valid 

ranges for the values.

NIFCONF_ERR_LOOP_IS_EMPTY

This loop does not contain any blocks.

NIFCONF_ERR_MACROCYCLE_CONFLICT

This macrocycle conflicts with a previously defined macrocycle time for a 

device in this loop. Devices can only schedule one macrocycle time. The 

best solution is to increase the macrocycle time of the loop that contains the 

other block(s) for this device.

NIFCONF_ERR_MACROCYCLE_NOT_GOOD_MULTIPLE

This macrocycle is a bad choice in comparison to the other macrocycles.

NIFCONF_ERR_MACROCYCLE_TOO_SHORT

There was not enough time in this macrocycle to schedule all the function 

blocks and parameters. Increase the macrocycle time of the loop to get 

more free time. A macrocyle generally must be at least 10 ms.

NIFCONF_ERR_MAXIMUM_LOOPS_EXCEEDED

The maximum number of loops you can configure on this link is exceeded.

NIFCONF_ERR_MISSING_NIFBUS_PATH

The install path for NI-FBUS Configurator is not in the Windows registry.
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NIFCONF_ERR_MULTI_LAS

Multiple primary Link Active Schedulers are defined. Only one primary 

LAS is allowed on a link.

NIFCONF_ERR_MULTI_TM

Multiple time masters are defined. Only one time master per link is 

allowed.

NIFCONF_ERR_NO_CONVERSION

There is no conversion for this data type.

NIFCONF_ERR_NO_DATA

No data.

NIFCONF_ERR_NO_LAS_SELECTED

A schedule has been created but no LAS is selected.

NIFCONF_ERR_NO_LM_SELECTED

A schedule has been created but no link master is selected.

NIFCONF_ERR_NO_OBJECT_SELECTED

Nothing is selected.

NIFCONF_ERR_NO_PRINTER_DEVICE_CONTEXT

The NI-FBUS Configurator cannot draw the document because of an 

incorrect device context for the selected printer.

NIFCONF_ERR_NO_TM_SELECTED

No time master is selected.

NIFCONF_ERR_NO_UNSCHEDULED_TIME_LEFT

The auto scheduler ran out of unscheduled time. Increase the macrocycle 

time(s) to allow more free time for scheduling.

NIFCONF_ERR_NOT_ON_LINK

This object does not belong on this link.

NIFCONF_ERR_OD_SIZE_MISMATCH

The size of the actual data object does not match the object dictionary size.



Appendix A Error Messages and Warnings

© National Instruments Corporation A-7 NI-FBUS Offline Configurator User Manual

NIFCONF_ERR_OUT_OF_MEMORY

Memory is low; the NI-FBUS Configurator cannot allocate objects. 

Close windows to solve this problem.

NIFCONF_ERR_PARAMETER_SCHEDULE_CONFLICT

A parameter communication has already been scheduled for this time. 

Do not schedule more than one parameter communication at a time on the 

Fieldbus.

NIFCONF_ERR_REGISTRY_ERROR

Some registry information for your application is missing or corrupt. 

You might need to reinstall the NI-FBUS software and the NI-FBUS 

Configurator. Refer to your getting started manual for installation 

instructions.

NIFCONF_ERR_STANDARD_DD_MISSING

The NI-FBUS Configurator could not find the standard device 

description file.

NIFCONF_ERR_STRING_NOT_FOUND

There is a missing resource string.

NIFCONF_ERR_TEMPLATE_NOT_ASSIGNED

The template is not assigned to a valid project object.

NIFCONF_ERR_TOO_MANY_FB_SCHEDULE_ENTRIES

The schedule for this object contains too many entries for the function 

block schedule of the device. Normally, bad choices for macrocycle times 

cause this error. Use macrocycle times that are integer multiples of each 

other to correct this problem.

NIFCONF_ERR_TOO_MANY_LAS_SCHEDULE_ENTRIES

The number of LAS schedule entries exceeds the number of available 

entries in the LAS device. Choose integer multiple macrocycle values and 

reduce the number of data links that go between devices to correct this 

problem.

NIFCONF_ERR_TYPE_INFO_UNAVAILABLE

The NI-FBUS Configurator cannot read the type information for the object.
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NIFCONF_ERR_UNSCHEDULED_TRAFFIC_CONFLICT

The publish time is conflicting with the reserved 128 octet time at the end 

of a macrocycle. This time is used for unscheduled traffic.

NIFCONF_ERR_WRONG_TYPE

This object has the wrong type.

NIFCONF_ERR_SAVE_OLDVERSION

This project is an old version and could not be saved. To avoid this error, 

convert the project to the latest version when you open the project.

NIFCONF_ERR_FILENAME_EMPTY

Empty filename. Normally, this error occurs when you specify a file 

without the name.

NIFCONF_ERR_UNSUPPORT_HSE

This project you are opening includes an unsupported HSE feature.

NIFCONF_ERR_CANT_DELETE_ONLY_ONE_LINK

The last link in the project cannot be deleted. A valid project includes at 

least one link.

NIFCONF_ERR_WHEN_DISCONNECT_LINKS

The system is busy and the links cannot be disconnected. Try your 

operation at a later time.

NIFCONF_ERR_EMPTY_TAG

The Empty tag is not permitted, per the Foundation Fieldbus specification.

NIFCONF_ERR_SPACE_IN_TAG

The space character is not permitted in the middle of the tag, per the 

Foundation Fieldbus specification.

NIFCONF_ERR_OPERATION_CONFLICT

Operation conflict.

NIFCONF_ERR_UNEXPECTED

An unexpected error has occurred.
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NIFCONF_ERR_NO_HOST_DEVICE

There is no host device in one or more H1 links.

NIFCONF_ERR_NO_MODE_SUPPORT

No run mode is supported currently.

NIFCONF_ERR_NO_RE_CONFIGURATION_SUPPORT

This version has no reconfiguration support.

NIFCONF_ERR_NO_BLOCK_MATCH

No block matches.

NIFCONF_ERR_NO_NP_MATCH

No network parameter matches.

NIFCONF_ERR_MAP_UNCOMPLETED

Device mapping is uncompleted.

NIFCONF_ERR_LINK_HAS_ACTIVE

The link to be online is active now; only one instance of a link can be active 

at a time.

E_INTERFACE_INVALID

This interface is invalid now.

E_UNDEFINED

The error is undefined.

E_OFFLINE_ERROR

Offline NI-FBUS error.

E_BLOCK_NOT_EXIST_IN_CFF

The block is undefined in the related .cff file.

E_MIB_PARAM_NAME_NOT_FOUND

The param name of MIB is not defined in the related .cff file.

E_OFF_DEVICE_NODE_INVALID

The offline device node is invalid.
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E_CFF_NOT_FOUND

The corresponding .cff file is not found.

E_NULL_POINTER

A null pointer happens.

E_DEVICE_NOT_FOUND

The device you are looking for is not found.

E_OFFLINE_NOT_SUPPORTED

This feature is not currently supported in Offline mode.

E_REVISON_EQUAL

The revision should not be equal.

E_SET_ADDRESS_FAILED

Setting address operation failed.

Warnings

If you receive a warning while using the NI-FBUS Configurator, refer to 

this section for a description of the warning and possible solutions.

NIFCONF_WARN_MEMORY_LOW

The system is low on memory.

NIFCONF_WARN_OBJECT_NOT_WIRED

This object is not connected by wires to any other object.

NIFCONF_WARN_NO_TREND_SELECTED

A trend is wired, but no trend is checked.

NIFCONF_WARN_TREND_NOT_WIRED

A trend is selected, but not wired to a device.

NIFCONF_WARN_PROJECT_ERRORS

There are errors that might cause problems in the download of the 

configuration. Look at the Errors tab in the status window.
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B
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 

ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions, 

visit our extensive library of technical support resources available 

in English, Japanese, and Spanish at ni.com/support. These 

resources are available for most products at no cost to registered 

users and include software drivers and updates, a KnowledgeBase, 

product manuals, step-by-step troubleshooting wizards, 

conformity documentation, example code, tutorials and 

application notes, instrument drivers, discussion forums, 

a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other 

measurement and automation professionals by visiting 

ni.com/support. Our online system helps you define your 

question and connects you to the experts by phone, discussion 

forum, or email.

• Training—Visit ni.com/training for self-paced tutorials, videos, 

and interactive CDs. You also can register for instructor-led, hands-on 

courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 

technical resources, or other project challenges, NI Alliance Program 

members can help. To learn more, call your local NI office or visit 

ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 

your local office or NI corporate headquarters. Phone numbers for our 

worldwide offices are listed at the front of this manual. You also can visit 

the Worldwide Offices section of ni.com/niglobal to access the branch 

office Web sites, which provide up-to-date contact information, support 

phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

m milli 10–3

Numbers

4-20 mA system Traditional control system in which a computer or control unit 

provides control for a network of devices controlled by 4-20 mA 

signals.

A

A Amperes.

Actuator A device that translates electrical signals into mechanical actions.

Acyclic communication Unscheduled communication on the bus.

Address Character code that identifies a specific location (or series of 

locations) in memory.

AI Analog Input.

Alarm A notification the NI-FBUS Communications Manager software 

sends when it detects that a block leaves or returns to a particular 

state.

Alarm condition A notification that a Fieldbus device sends to another Fieldbus device 

or interface when it leaves or returns to a particular state.

Alert An alarm or event.

Analog A description of a continuously variable signal or a circuit or device 

designed to handle such signals.

AO Analog Output.

API See Application Programmer Interface. 

Application Programmer 

Interface

A message format that an application uses to communicate with 

another entity that provides services to it.
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Argument A value you pass in a function call. Sometimes referred to as a 

parameter, but this documentation uses a different meaning for 

parameter, which is included in this glossary.

Array Ordered, indexed list of data elements of the same type.

Attribute Properties of parameters.

B

Bank The combination of one FieldPoint network module and one or more 

terminal bases and I/O modules.

Basic device A device that can communicate on the Fieldbus, but cannot become 

the LAS.

Block A logical software unit that makes up one named copy of a block and 

the associated parameters its block type specifies. The values of the 

parameters persist from one invocation of the block to the next. It can 

be a resource block, transducer block, or function block residing 

within a virtual field device.

Block tag A character string name that uniquely identifies a block on a Fieldbus 

network.

Boolean Logical relational system having two values, each the opposite of the 

other, such as true and false or zero and one.

Buffer Temporary storage for acquired or generated data.

Bus The group of conductors that interconnect individual circuitry in a 

computer. Typically, a bus is the expansion vehicle to which I/O or 

other devices are connected. Examples of PC buses are the ISA and 

PCI buses.

Bus scheduler See Link Active Scheduler.

C

C Celsius.

Channel A pin or wire lead to which you apply or from which you read the 

analog or digital signal.

Character string name See Tag.

Configuration object See Linkage.
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Contained parameter A parameter that does not receive or send data and is contained within 

a function block.

Control loop A set of connections between blocks used to perform a control 

algorithm.

Control strategy See Function Block Application.

Cyclic Closed-loop control.

D

Data Link Layer The second-lowest layer in the ISO seven-layer model (layer two). 

The Data Link Layer splits data into frames to send on the physical 

layer, receives acknowledgment frames, and re-transmits frames if 

they are not received correctly. It also performs error checking to 

maintain a sound virtual channel to the next layer.

Data link time 

synchronization

A time distribution message broadcast on the Fieldbus so that all 

devices have exactly the same data link time.

dB Decibel.

DD See Device Description. 

Descriptor A number returned to the application by the NI-FBUS 

Communications Manager, used to specify a target for future 

NI-FBUS calls.

Device A sensor, actuator, or control equipment attached to the Fieldbus.

Device address A memory address that you use to access a device in a computer 

system.

Device Description A machine-readable description of all the blocks and block 

parameters of a device.

Device Description Service A set of functions that applications use to access Device 

Descriptions.

Device ID An identifier for a device that the manufacturer assigns. No two 

devices can have the same device ID.

Device tag A name you assign to a Fieldbus device.

DI Discrete Input.

Distributed control Process control distributed among several devices connected by 

network.
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DLL See Dynamic Link Library.

DO Discrete Output.

Dynamic Link Library A library of functions and subroutines that links to an application at 

run time.

E

Event An occurrence on a device that causes a Fieldbus entity to send the 

Fieldbus event message.

F

FAS Fieldbus Access Sublayer. 

FB Function Block.

FBAP See Function Block Application.

FF Foundation Fieldbus.

Field device A Fieldbus device connected directly to a Fieldbus.

Fieldbus An all-digital, two-way communication system that connects control 

systems to instrumentation. A process control local area network 

defined by ISA standard S50.02.

Fieldbus Foundation An organization that developed a Fieldbus network specifically based 

upon the work and principles of the ISA/IEC standards committees.

Foundation Fieldbus 

specification

The communications network specification that the Fieldbus 

Foundation created.

FP-3000 National Instruments network interface module for the FieldPoint I/O 

system.

FTP File Transfer Protocol.

Function block A named block consisting of one or more input, output, and contained 

parameters. The block performs some control function as its 

algorithm. Function blocks are the core components you control a 

system with. The Fieldbus Foundation defines standard sets of 

function blocks. There are ten function blocks for the most basic 

control and I/O functions. Manufacturers can define their own 

function blocks.

Function Block Application The block diagram that represents your control strategy.
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Function Block Application 

Editor window

The middle window of the NI-FBUS Configurator where you create 

your block diagram.

Function block execution 

schedule

A list of times in the macrocycle when the function block will begin 

to execute its algorithm.

H

H1 The 31.25 kbit/s type of Fieldbus.

hex Hexadecimal. A base-16 numbering system which uses 0–9 and A–F.

HMI Human-Machine Interface. A graphical user interface for the process 

with supervisory control and data acquisition capability.

Host device A computer or controller on a Fieldbus network.

HSE High Speed Ethernet.

I

I/O Input/output.

Index An integer that the Fieldbus specification assigns to a Fieldbus object 

or a device that you can use to refer to the object. A value in the object 

dictionary used to refer to a single object.

Input parameter A block parameter that receives data from another block.

IRQ Interrupt request.

ISO International Organization for Standardization. A technical standards 

organization that creates international technical standards for 

computers and communications. The ISO is composed of national 

standards organizations in 89 countries. The American National 

Standards Institute (ANSI) represents the United States in the ISO.

Isolation A type of signal conditioning in which you isolate the transducer 

signals from the computer for safety purposes. This protects you and 

your computer from large voltage spikes and makes sure the 

measurements from the devices are not affected by differences in 

ground potentials.



Glossary

NI-FBUS Offline Configurator User Manual G-6 ni.com

L

LAS See Link Active Scheduler.

Link A Foundation Fieldbus network is made up of devices connected by 

a serial bus. This serial bus is called a link (also known as a segment). 

Link Active Schedule A schedule of times in the macrocycle when devices must publish 

their output values on the Fieldbus.

Link Active Scheduler The Fieldbus device that is currently controlling access to the 

Fieldbus. A device that is responsible for keeping a link operational. 

The LAS executes the link schedule, circulates tokens, distributes 

time, and probes for new devices.

Link master device A device that is capable of becoming the LAS.

Linkage A connection between function blocks.

Linkage object An object resident in a device that defines connections between 

function block input and output across the network. Linkage objects 

also specify trending connections.

LM Link Master.

Lookout National Instruments Lookout is a full-featured object-based 

automation software system that delivers unparalleled power and 

ease of use in demanding industrial measurement and automation 

applications.

Loop See Control loop.

M

Macrocycle The least common multiple of all the loop times on a given link, or 

one iteration of a the process control loop.

Manufacturer’s identification An identifier used to correlate the device type and revision with its 

device description and device description revision.

Menu An area accessible from the command bar that displays a subset of the 

possible command choices. In the NI-FBUS Configurator, refers to 

menus defined by the manufacturer for a given block.

Method Methods describe operating procedures to guide a user through a 

sequence of actions.

Mode Type of communication.
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N

NI-FBUS API The NI-FBUS Communications Manager.

NI-FBUS Communications 

Manager

Software shipped with National Instruments Fieldbus interfaces that 

lets you read and write values. It does not include configuration 

capabilities.

NI-FBUS Configurator National Instruments Fieldbus configuration software. With it, you 

can set device addresses, clear devices, change modes, and read and 

write to the devices.

NI-FBUS Fieldbus 

Configuration System

See NI-FBUS Configurator.

NI-FBUS process Process that must be running in the background for you to use your 

AT-FBUS or PCMCIA-FBUS interface to communicate between the 

board and the Fieldbus.

Nifb.exe The NIFB process that must be running in the background for you to 

use your AT-FBUS or PCMCIA-FBUS interface to communicate 

between the board and the Fieldbus.

Non-volatile memory Memory that does not require electricity to hold data.

O

Object An element of an object dictionary.

Object description Describes data that is communicated over the Fieldbus.

Object Dictionary A structure in a device that describes data that can be communicated 

on the Fieldbus. The object dictionary is a lookup table that gives 

information such as data type and units about a value that can be read 

from or written to a device.

Octet A single 8-bit value.

OD See Object Dictionary. 

Offline Not connected to or installed in the computer.

OOS Out of Service mode.

OPC OLE for Process Control.

Output parameter A block parameter that sends data to another block.
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P

Parameter One of a set of network-visible values that makes up a function block.

PC Personal Computer.

PCMCIA Personal Computer Memory Card International Association.

PD Proportional Derivative.

PDU Protocol Data Unit.

PID Proportional/Integral/Derivative. A common control function block 

algorithm that uses proportions, integrals, and derivatives in 

calculation.

PLC See Programmable Logic Controller.

PN Probe Node.

Poll To repeatedly inspect a variable or function block to acquire data.

Port A communications connection on a computer or remote controller.

Process variable A common Fieldbus function block parameter representing some 

value in the process being controlled.

Programmable Logic 

Controller

A device with multiple inputs and outputs that contains a program 

you can alter.

PT Pass Token.

Publisher A device that has at least one function block with its output value 

connected to the input of another device.

Publishing schedule Determines when data members are published over the Fieldbus.

PV Process Variable.

R

RA Ratio.

Resource block A special block containing parameters that describe the operation 

of the device and general characteristics of a device, such as 

manufacturer and device name. Only one resource block per device 

is allowed.
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S

s Seconds.

Sample type Specifies how trends are sampled on a device, whether by averaging 

data or by instantaneous sampling.

Scheduled/cyclic 

communications

Communication that occurs at the same time during each control 

cycle.

Segment See Link.

Sensor A device that responds to a physical stimulus (heat, light, sound, 

pressure, motion, flow, and so on), and produces a corresponding 

electrical signal.

Server Device that receives a message request.

Service Services allow user applications to send messages to each other 

across the Fieldbus using a standard set of message formats.

Session A communication path between an application and the NI-FBUS 

Communications Manager.

Stack A set of hardware registers or a reserved amount of memory used for 

calculations or to keep track of internal operations.

Stale Data that has not been updated for stale_limit number of 

macrocycles, where the stale limit is a parameter of the connection.

Subscriber A device that has at least one function block with its input value 

connected to the output of another device.

Symbol file A Fieldbus Foundation or device manufacturer-supplied file that 

contains the ASCII names for all the objects in a device.

T

Tag A name you can define for a block, virtual field device, or device.

Timeout A period of time after which an error condition is raised if some event 

has not occurred.

Traditional system See 4-20 mA system.



Glossary

NI-FBUS Offline Configurator User Manual G-10 ni.com

Transducer block A block that is an interface to the physical, sensing hardware in 

the device. It also performs the digitizing, filtering, and scaling 

conversions needed to present input data to function blocks, and 

converts output data from function blocks. Transducer blocks 

decouple the function blocks from the hardware details of a given 

device, allowing generic indication of function block input and 

output. Manufacturers can define their own transducer blocks.

Trend A Fieldbus object that allows a device to sample a process variable 

periodically, then transmit a history of the values on the network.

Trend function An NI-FBUS call related to trends.

U

Unscheduled Messages sent on the Fieldbus between transmissions of scheduled 

messages.

Upstream Fewer network hops away from a backbone or hub. For example, a 

small ISP that connects to the Internet through a larger ISP that has 

their own connection to the backbone is downstream from the larger 

ISP, and the larger ISP is upstream from the smaller ISP.

V

VFD See Virtual Field Device. 

View objects Predefined groupings of parameter sets that HMI applications use.

Virtual Field Device The virtual field device is a model for remotely viewing data 

described in the object dictionary. The services provided by the 

Fieldbus Messaging Specification allow you to read and write 

information about the object dictionary, read and write the data 

variables described in the object dictionary, and perform other 

activities such as uploading/downloading data and invoking 

programs inside a device. A model for remotely viewing data 

described in the object dictionary.



© National Instruments Corporation I-1 NI-FBUS Offline Configurator User Manual

Index

A
add virtual devices

figure, 3-5

new address and new tag (figure), 3-6

C
capability file, selecting (figure), 2-3

configuration tree, 1-3

configure function block application, 3-7

conventions used in the manual, v

create a new project, 3-2

project type selection (figure), 3-4

D
DD info dialog box (figure), 2-2

device descriptions

importing

DD info dialog box (figure), 2-2

import DD dialog box (figure), 2-2

NI-FBUS Interface Configuration 

Utility (figure), 2-1

selecting the capability file (figure), 2-3

devices added into Fieldbus (figure), 3-7

diagnostic tools (NI resources), B-1

documentation (NI resources), B-1

drivers (NI resources), B-1

E
error messages

E_BLOCK_NOT_EXIST_IN_CFF, A-9

E_CFF_NOT_FOUND, A-10

E_DEVICE_NOT_FOUND, A-10

E_INTERFACE_INVALID, A-9

E_MIB_PARAM_NAME_NOT_FOUND, 

A-9

E_NULL_POINTER, A-10

E_OFF_DEVICE_NODE_INVALID, A-9

E_OFFLINE_ERROR, A-9

E_OFFLINE_NOT_SUPPORTED, A-10

E_REVISON_EQUAL, A-10

E_SET_ADDRESS_FAILED, A-10

E_UNDEFINED, A-9

NIF_ERR_ALARM_ACKNOWLEDGED, 

A-1

NIF_ERR_BAD_ARGUMENT, A-1

NIF_ERR_BAD_DEVICE_DATA, A-1

NIF_ERR_BUF_TOO_SMALL, A-1

NIF_ERR_COMM_ERROR, A-1

NIF_ERR_CONFIG_ERROR, A-1

NIF_ERR_DATA_NEVER_WRITABLE, 

A-1

NIF_ERR_DEVICE_NOT_PRESENT, 

A-2

NIF_ERR_EXCEED_LIMIT, A-2

NIF_ERR_INVALID_DESCRIPTOR, A-2

NIF_ERR_MULTIPLE, A-2

NIF_ERR_NOT_FOUND, A-2

NIF_ERR_OBJECT_ACCESS_

DENIED, A-2

NIF_ERR_OBJECT_ACCESS_

UNSUPPORTED, A-2

NIF_ERR_OBSOLETE_DESC, A-2

NIF_ERR_ORDINAL_NUM_OUT_OF_

RANGE, A-2

NIF_ERR_PARAMETER_CHECK, A-2

NIF_ERR_RESOURCES, A-2

NIF_ERR_SERVER_CONNECTION_

LOST, A-3

NIF_ERR_SERVER_NOT_

RESPONDING, A-3
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NIF_ERR_SM_NOT_OPERATIONAL, 

A-3

NIF_ERR_SYMBOL_FILE_NOT_

FOUND, A-3

NIF_ERR_TIMEOUT, A-3

NIF_ERR_WRITE_IS_PROHIBITED, 

A-3

NIF_ERR_WRONG_MODE_FOR_

REQUEST, A-3

NIFCONF_ERR_ADDRESS_OUT_OF_

RANGE, A-3

NIFCONF_ERR_ADDRESS_USED, 

A-3

NIFCONF_ERR_BAD_WIRE, A-3

NIFCONF_ERR_BLOCK_

SCHEDULE_CONFLICT, A-3

NIFCONF_ERR_BUF_TOO_SMALL, 

A-4

NIFCONF_ERR_CANT_DELETE_

ONLY_ONE_LINK, A-8

NIFCONF_ERR_CONFIGURING, A-4

NIFCONF_ERR_CONFUSED_WIRE, 

A-4

NIFCONF_ERR_CORRUPT_FILE, A-4

NIFCONF_ERR_COULD_NOT_

DETERMINE_SCHEDULE, A-4

NIFCONF_ERR_COULD_NOT_

START_THREAD, A-4

NIFCONF_ERR_DD_SIZE_

MISMATCH, A-4

NIFCONF_ERR_DEVICE_NOT_

ALIVE, A-4

NIFCONF_ERR_DOWNLOAD_

INCOMPLETE, A-4

NIFCONF_ERR_DUPLICATE_

ADDRESS, A-4

NIFCONF_ERR_DUPLICATE_TAG, 

A-4

NIFCONF_ERR_EMPTY_TAG, A-8

NIFCONF_ERR_FILENAME_EMPTY, 

A-8

NIFCONF_ERR_INCOMPATIBLE_

VERSION, A-5

NIFCONF_ERR_INVALID_

MACROCYCLE, A-5

NIFCONF_ERR_INVALID_NUMBER, 

A-5

NIFCONF_ERR_INVALID_TAG, A-5

NIFCONF_ERR_INVALID_VALUE, 

A-5

NIFCONF_ERR_LINK_HAS_ACTIVE, 

A-9

NIFCONF_ERR_LOOP_IS_EMPTY, 

A-5

NIFCONF_ERR_MACROCYCLE_

CONFLICT, A-5

NIFCONF_ERR_MACROCYCLE_

NOT_GOOD_MULTIPLE, A-5

NIFCONF_ERR_MACROCYCLE_

TOO_SHORT, A-5

NIFCONF_ERR_MAP_

UNCOMPLETED, A-9

NIFCONF_ERR_MAXIMUM_LOOPS_

EXCEEDED, A-5

NIFCONF_ERR_MISSING_NIFBUS_

PATH, A-5

NIFCONF_ERR_MULTI_LAS, A-6

NIFCONF_ERR_MULTI_TM, A-6

NIFCONF_ERR_NO_BLOCK_

MATCH, A-9

NIFCONF_ERR_NO_CONVERSION, 

A-6

NIFCONF_ERR_NO_DATA, A-6

NIFCONF_ERR_NO_HOST_DEVICE, 

A-9

NIFCONF_ERR_NO_LAS_

SELECTED, A-6

NIFCONF_ERR_NO_LM_SELECTED, 

A-6

NIFCONF_ERR_NO_MODE_

SUPPORT, A-9

NIFCONF_ERR_NO_NP_MATCH, A-9
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NIFCONF_ERR_NO_OBJECT_

SELECTED, A-6

NIFCONF_ERR_NO_PRINTER_

DEVICE_CONTEXT, A-6

NIFCONF_ERR_NO_RE_

CONFIGURATION_SUPPORT, A-9

NIFCONF_ERR_NO_TM_SELECTED, 

A-6

NIFCONF_ERR_NO_

UNSCHEDULED_TIME_LEFT, A-6

NIFCONF_ERR_NOT_ON_LINK, A-6

NIFCONF_ERR_OD_SIZE_

MISMATCH, A-6

NIFCONF_ERR_OPERATION_

CONFLICT, A-8

NIFCONF_ERR_OUT_OF_MEMORY, 

A-7

NIFCONF_ERR_PARAMETER_

SCHEDULE_CONFLICT, A-7

NIFCONF_ERR_REGISTRY_ERROR, 

A-7

NIFCONF_ERR_SAVE_

OLDVERSION, A-8

NIFCONF_ERR_SPACE_IN_TAG, A-8

NIFCONF_ERR_STANDARD_DD_

MISSING, A-7

NIFCONF_ERR_STRING_NOT_

FOUND, A-7

NIFCONF_ERR_TEMPLATE_NOT_

ASSIGNED, A-7

NIFCONF_ERR_TOO_MANY_FB_

SCHEDULE_ENTRIES, A-7

NIFCONF_ERR_TOO_MANY_LAS_

SCHEDULE_ENTRIES, A-7

NIFCONF_ERR_TYPE_INFO_

UNAVAILABLE, A-7

NIFCONF_ERR_UNEXPECTED, A-8

NIFCONF_ERR_UNSCHEDULED_

TRAFFIC_CONFLICT, A-8

NIFCONF_ERR_UNSUPPORT_HSE, 

A-8

NIFCONF_ERR_WHEN_

DISCONNECT_LINKS, A-8

NIFCONF_ERR_WRONG_TYPE, A-8

errors. See error messages

examples (NI resources), B-1

H
help, technical support, B-1

I
import DD dialog box (figure), 2-2

importing device descriptions

DD info dialog box (figure), 2-2

import DD dialog box (figure), 2-2

NI-FBUS Interface Configuration Utility 

(figure), 2-1

selecting the capability file (figure), 2-3

instrument drivers (NI resources), B-1

K
KnowledgeBase, B-1

M
mapping and downloading, 3-8

erase conflicts and perform mapping 

(figure), 3-10

initializing the link (figure), 3-8

partially mapped link, 3-11

select target tags and addresses 

(figure), 3-9

middle frame

examples (figure), 1-4

N
National Instruments support and 

services, B-1
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NI-FBUS Configurator

main window, components (figure), 1-2

middle frame, examples (figure), 1-4

NI-FBUS Interface Configuration Utility 

(figure), 2-1

NI-FBUS Offline Communications Manager

starting (figure), 3-2

NI-FBUS Offline Configurator

create a new project, 3-2

project type selection (figure), 3-4

create a new project (figure), 3-3

figure, 3-3

main window

configuration tree, 1-3

elements (figure), 1-2

opening, 1-1

status window, 1-3

overview, 1-1

using, 3-1

add virtual devices, 3-4

devices added into Fieldbus 

(figure), 3-7

figure, 3-5

new address and new tag 

(figure), 3-6

choosing an interface type 

(figure), 3-1

configure function block 

application, 3-7

mapping and downloading, 3-8

erase conflicts and perform 

mapping (figure), 3-10

initializing the link (figure), 3-8

partially mapped link, 3-11

select target tags and addresses 

(figure), 3-9

starting the NI-FBUS Offline 

Communications Manager 

(figure), 3-2

starting the process, 3-1

virtual device type in device tree 

(figure), 1-3

windows, main window, 1-1

P
programming examples (NI resources), B-1

R
run mode, 1-4

S
software (NI resources), B-1

status window, 1-3

support, technical, B-1

T
technical support, B-1

training (NI resources), B-1

troubleshooting (NI resources), B-1

W
warning messages

NIFCONF_WARN_MEMORY_LOW, 

A-10

NIFCONF_WARN_NO_TREND_

SELECTED, A-10

NIFCONF_WARN_OBJECT_NOT_

WIRED, A-10

NIFCONF_WARN_PROJECT_

ERRORS, A-10

NIFCONF_WARN_TREND_NOT_

WIRED, A-10

warnings. See warning messages

Web resources, B-1
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